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1 INTRODUCTION 

 Artemis is a modular handheld console that can be configured as a diver target 
detection sonar and GPS underwater navigation aid.  
 
Primarily designed to assist divers in localizing and relocating objects on the seabed, 
Artemis is specifically optimized for use by Naval Mine Clearance and EOD Divers to 
relocate items of ordnance as an alternative to conducting a tactile or circular search 
around a known datum. 
 
Typical uses are search & relocation of… 
 Unexploded ordnance by navy mine clearance divers, commercial EOD divers, etc. 

 Seabed infrastructure within the offshore oil & gas environment (e.g. pipelines, well 
heads, structures). 

 Missing persons, lost property, vehicles, aircraft, wrecks by police or search & 
rescue divers. 

 Seabed/lakebed antiquities by marine biologists, archaeologists, sports divers, etc. 
 
Artemis is intuitive and straightforward to use. The interface has been designed by 
divers for divers. The user can quickly interpret information presented via the simple 
menu interface and graphical display. Sonar, Navigation and other apps are selected 
and controlled via a simple 5-button interface. 
 
Using the ‘plug-and-play’ USB connection, data can be transferred between the internal 
Flash storage on Artemis and a Microsoft® Windows® based PC or laptop. The “Artemis 
Manager” PC software allows pre-dive creation of “Mission” files (to assist with search 
and navigation tasks), and post-dive analysis of “Dive Log” files containing sonar 
imagery, area covered, dive-placed markers-of-interest etc. 
 
 
 
 

 Before proceeding, we recommend that you read the safety, deployment and operation 
guidelines in this user guide, in order to get full benefit from the features of the 
Artemis system. 
 
Throughout this document the following symbols are used to indicate special 
precautions or procedures you should note… 
 

 

WARNING! 
This symbol indicates a warning you should follow of to avoid bodily injury and damage 
to your equipment. 
 

 

CAUTION 
This symbol denotes precautions and procedures you should follow to avoid damage to 
your equipment. 
 

 

NOTE 
This symbol denotes special instructions or tips that should help you get the best 
performance from your Artemis system. 
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2 SYSTEM CONTENTS 

 

Before proceeding, please check that your system contains the following 
items… 

Part 
Number 

  Artemis console, with… 

o Artemis display unit 

o Artemis battery holder 

o Swim-board frame with compass 
module 

o Scanning sonar and cable 

o Analogue compass module 

BP00707

 o Serial Port Blanking Plugs 

o USB Port Blanking Plug 

 

 
 

BP00946
BP00947

  Artemis GPS Float and cable 
management skid with securing pin. 

 
 
 

BP00845 

  16.8V, 2.2Ah rechargeable NiMH 
battery pack.  

BP00642

  Universal AC supply, smart 3-stage 
battery charger (with international 
power adapters).  

 
 

BP00648

  USB adapter lead.  

 Artemis PC software CD. 

 User Guide. 

 Transit Case 

 BP00949
 

BP00696
 

BP00697 
 

BP00700

  
You will also need… 
 Microsoft “Windows XP / Vista / 7 / 8” compatible computer, with… 

o 1 free USB port (for connection to Artemis) 

o CD-ROM drive (or internet connection) for software installation. 
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3 PREPARING ARTEMIS 

 
3.1 Identifying Component Parts 
The diagram below shows the main component parts of the Artemis Console… 
 
 

 
 

 Display & Keypad  Battery Housing Cap 

 Frame  Blanking Plugs (Serial & USB) 
(for unused connectors) 

 Battery Housing  Analogue Compass Module 

 Battery Pack  Sonar Module 

 
 
The following sections discuss the operation of these components in greater detail… 
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 3.1.1 Keypad 
The 5-button keypad is located on the front of the Artemis display. For durability, the 
buttons use a ‘piezo’ pressure sensing technology and require a firm push to operate. 
 
The button functions and labelled and defined as… 
 

 

F1/Up 
Selects Function 1, or moves the 
selection/cursor up.  

F3/Left 
Selects Function 3, or moves the 
selection/cursor left. 

 

F2/Down 
Selects Function 2, or moves the 
selection/cursor down.  

F4/Right 
Selects Function 4, or moves the 
selection/cursor right. 

 

Power/App 
Used to power up the unit, and 
cycle through displays. 

  

  

 3.1.2 Connectors 
Connectors are located along the bottom edge of the Artemis Console, and labelled for 
the following functions… 
 

 

Battery / DC Power 
Connects to the battery housing 
cap)  

Serial Port 1 
Connects to the Sonar. 

 

USB Connector 
Connects to PC for transferring 
‘mission’ and ‘dive’ files. 

 
Serial Port 2 
Connects to the GPS Float. 

   
Serial Port 3 
Connects to additional sensors. 

  

 

Blanking plugs MUST ALWAYS be fitted in external connectors that are not in 
use otherwise water ingress may erode or damage the connector contacts. 
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3.2 Important Considerations 
Before using your Artemis System, please read and follow these safety considerations… 
If you have any other safety or operational queries, please contact Artemis technical 
support (see page 64). 

 
3.2.1 Operation 
 Do not rely on this product or its sensors as a primary means of life-support during 

or after a dive. Artemis is designed as a survey tool, and not as an alternative or 
replacement for dive-computers or similar apparatus. 

 Do not use this product if any of the cabling, or housings of its component parts 
appear to be damaged or compromised for the ingress of water (where required to 
be watertight). 

 Do not attempt to disassemble or service this product yourself (outside the scope 
described in this manual). Contact Artemis technical support for any maintenance, 
spares or repair work required. 

 

 Do not submerge the console, unless all blanking plugs are fitted in unused 
electrical connector sockets, and the battery housing cap is secured. 

 
 

 

3.2.2 Maintenance & Cleaning 
When you have finished using your Artemis system, you should… 
 Wash the system in fresh water, if it has been used in salt-water, to prevent 

corrosion and damage to rubber mouldings. 

 Remove any weed, or other detritus, that may have been collected during its 
operation. 

Additionally please observe the following precautions for cleaning and maintenance… 

 Do not clean with solvents, and only use a damp cloth on the exterior of the unit. 

 Do not undertake maintenance of the unit, outside the scope of that defined within 
this manual, unless instructed to do so by technical support. 

 Do not attempt to modify any of the system cables, power cords or plugs. 

 Do not insert extraneous objects (metal or other) into the unit or any of its 
connector apertures. 

 

 
 
 
 
 
 
 
 
 
 

 

3.2.3 Storage 
When storing or shipping the Artemis system, please observe the following… 
 Do not store the unit in direct or strong sunlight, as this may cause surfaces or 

transparent windows to discolour, perish cable insulation and other rubber 
mouldings. 

 To prevent corrosion, remove any salt or other residues from the product before 
storage. 

 Store in the recommended temperature range (see page 67), and avoid excessive 
and large fluctuations in temperature.  

 Store in a well ventilated enclosure after use, to allow any moisture on system 
components to evaporate naturally. 

 Do not store battery packs in a discharged state, as this may reduce operational life 
or cause premature ageing of the cell. When storing batteries for more than one 
year, charge at least once a year to prevent leakage and deterioration of 
performance due to self-discharging. 

 

 Do not leave battery packs in the battery housing for long periods of 
storage, and cells may leak and damage the seals and interior of the 
housing. 
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3.3 Charging the Battery Pack 
Artemis is supplied with a fast Nickel Metal-Hydride (NiMH) battery charger, for use 
with Artemis Battery Packs. 
 

 

 

Safety Notices… 
 Do not use any charger, other than the supplied Artemis charger with the Artemis 

NiMH battery packs. 

 Batteries should be disconnected from the charger when not in use (to prevent slow 
discharge). 

 The charger is designed for indoor use only and should not be exposed to water 
or dust. The charger housing is double insulated (insulation class II). 

 Do not cover up the charger when in use 

 The charger is turned on by connecting it to the mains socket. Disconnecting it from 
the mains socket turns it off 

 The mains socket should be easily accessible. If an operational error occurs, the 
plug should be immediately removed from the socket. 

 If the charger cord or housing is damaged, the charger must not be used 

 The charger contains dangerous voltages and the cover should not be removed. All 
service or maintenance work should be carried out by qualified personnel. For 
further assistance please refer to the “ Product Support” section (on page 64) of 
this manual. 

 Avoid exposing the chargers housing to oils, grease, etc., as these chemicals and 
solvents may break down the plastic. 

 

 To charge the battery pack… 
 Remove the battery back from the Artemis Battery Housing (by unscrewing the 

Battery Cap) before charging. 

 Plug the charging lead into the socket at the end of the battery pack… 
 

 
 
 The charger is started by connecting the battery pack to the charger, and switching 

the charger on at the mains socket.  

 The charger indicator will be yellow before the fast charge starts, and turns to 
orange when charging commences.  

 When the batteries are approaching fully charged, the charger will enter its ‘top-off’ 
charge mode (where the indicator will be green with an intermittent yellow flash), 
and finally enter ‘trickle’ charge mode (where the indicator is permanently green). 

 Charging is complete when the charge is in ‘trickle’ mode (permanent green 
indicator), and the batteries can be left connected for long periods (up to 24-hours 
max recommended) without suffering any damage. 

 If new batteries are to be connected, the charger must be idle for at least 15 
seconds to make sure its charge cycle resets correctly. When the indicator turns 
yellow this shows a new charge cycle can begin. 
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  Indicator Colour Mode 

 Yellow 
Battery not connected, 
or initialisation and 
analysis. 

 Orange Bulk charge 

 
Green with 
intermittent fast 
yellow flash 

Top-off charge 

 Green 
Trickle charge 
(complete) 

 
Alternating slow 
orange/green flash 

Error 
 

 

When connected to a flat battery pack, a full charge should take approximately 7 hours 
to complete – batteries that are not completely flat should take less time to charge. 

 

The charger features a safety timer that prevents excessive amounts of charge being 
delivered. If the battery is not holding charge, or being charged from a very discharged 
state, the safety timer might expire (after 7 hours). In this case the indicator will 
alternate between orange and green, and turning the charger off at the mains will clear 
the error.  
 
You may attempt to continue charging the battery, and for ‘good’ batteries the error 
should not occur again until charging is complete on the second attempt. However, if 
the error keeps occurring, the battery has most likely reached the end of its life, and 
do not attempt further charges. 

 
 
 

3.4 Connecting the Battery 

 

 

Safety Notices… 
 Do not allow the battery to be exposed to water, or any other substance that 

may cause an electrical short between battery terminals. 

 If the battery housing or protective wrapping is damaged, avoid using the battery 

 Always charge the battery in a well ventilated area. Never charge the battery in a 
sealed container. 

 Avoid repeatedly re-charging the battery without allowing for a minimum 30 minute 
cooling period between charge cycles. 

 During charging the battery pack will get warm, but typically this should be no 
more than 25-30°C above the ambient temperature. Disconnect the charger and 
allow to cool if the batteries exceed this. 

 As charging nears completion, the battery temperature will rise by approx 5°C. 

 Avoid charging the batteries at excessively high or low ambient temperatures, as 
this may affect the charge rate and charge-termination methods. If possible charge 
between 10°C and 30°C. 

 The battery pack contains a thermal fuse and current fuse. Temperatures in excess 
of 85°C, and discharge currents over 5A will cause these fuses to blow. 

 Do not place any metal (or electrically conductive) objects in the battery connector, 
other than those specified in this manual (i.e. the charge plug). 

 Use only the supplied Artemis Battery Charger with the battery pack. Do not use 
any other type of NiMH battery charger, as this may damage the battery pack, or 
lead to excessive heating. 

 Batteries should be disconnected from the charger when not in use (to prevent slow 
discharge). 
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 Once the battery has been charged successfully, it can be connected to the Artemis 

console with the following steps… 
 
 If the Artemis console already contains a battery, first check the console is turned 

off (see the “Turning Power On & Off” section from page 18). 

 Dry any excess moisture from around the battery housing to prevent ingress and 
contact with the battery pack. 

 Unscrew the battery housing cap in the anti-clockwise direction… 
As the battery housing is sealed, you may hear the internal pressure equalising with 
atmospheric pressure as the seals release. Wait until any pressure equalisation 
finishes before completely removing the cap.  

 

When opening or closing the battery cap, hold the bend restrictor in the 
orientation shown below to prevent excess strain from being placed on the 
cable. 

  

 
 

 

 Check there is not dirt on the o-ring seals inside the battery cap, or around the 
inside of the mouth of the battery holder. If necessary, use a lint-free cotton-bud to 
wipe clean and apply a small amount of silicone grease. 

  Insert the battery pack, feet first, into the battery holder.  

 Align the plug on the inside of the battery cap, with the socket on the battery pack 
and push together.  

 Screw the battery cap in a clockwise direction to secure and seal the battery holder. 
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3.5 Care & Storage of Batteries 
When not in use, batteries should be stored in a fully charged state. The chemistry of 
the nickel metal hydride battery pack will self-discharge approximately 1% of its 
charged capacity per day (up to 30% per month). 
 
The self-discharge rate varies greatly with temperature, where lower storage 
temperature leads to slower discharge rate and longer battery life. The self-discharge 
is 5% – 20% on the first day, and stabilizes around 1% per day at room temperature 
(at 45°C it's approximately 3 times as high). 
 

 

During long term storage, it is recommended that the battery pack be re-charged at 
least once every six month period. Storage for long periods in a discharged state may 
permanently reduce the capacity of the battery pack or lead to the pack leaking. 
 

 

Do not store the Artemis console for extended periods of time with the battery 
inserted. If the battery pack leaks it may damage the interior and seals of the 
battery housing. 

  
When charging for the first time after long term storage, internal chemical changes 
within the battery cells may lead to increased voltage, and decreased capacity. Restore 
such batteries to original performance by repeating several cycles of charging and 
discharging. 
 
Batteries should be disconnected from the charger when not in use (to prevent slow 
discharge through the charger circuitry). 
 
Avoid repeatedly re-charging the battery without allowing for a minimum 30 minute 
cooling period between charge cycles. 
 
For best performance, it is recommended to store batteries in a dry location with low 
humidity, no corrosive gasses, and at temperature range of -10°C to +35°C. 
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3.6 External Sensors Connections 

 Several external sensors, such as the Sonar 
and GPS Float, can be connected to the 
Artemis console. 
 
The sensors care connected to the “Serial 
Sensor” ports located on the bottom edge of 
the Artemis housing, and identified by the 
following symbols… 
 

  Serial Port 1 

  Serial Port 2 

  Serial Port 3 

 
Power is controlled to each port by Artemis 
as the sensor is required for use. 
 

 
Only sensors supported by the Artemis software should be connected to the console. 

  

3.6.1 Sonar 
If the sonar was specified at the time the system was ordered, it will be fitted and 
configured prior to delivery.  
By default the sonar is connected to Serial Port 1. However, firmware settings on 
Artemis allow this to be changed. 
For further details on using the Sonar, please refer to the “Sonar Application” section 
on page 25, and “Understanding Sonar Imagery” on page 60. 
 

3.6.2 GPS Float 
If being used with the system, by default the GPS Float should be connected to Serial 
Port 2 (although this may be changed under the Artemis software settings). 
For further details on navigating with the GPS Float, please refer to the “Navigation 
Application” section on page 26. 
 

 3.6.3 Sensor Power 
To save battery life during a mission, power to the two sensor serial ports can be 
switched on or off from the “Power Application” as required by the diver. By default, 
power to both sensors is switched on when Artemis is powered up. See section 4.1.3 
for further details. 
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3.7 Compass Modules 

 When configuring Artemis prior to a dive, the user can choose between the two 
compass options depending on the type of operation required… 
 

3.7.1 Analogue (Magnetic) Compass 

 For situations that do not require the use of the in-built navigation system, the 
Analogue Compass module can be used to provide a simple and robust magnetic 
heading for the diver. 
 

 

Unlike the inbuilt Digital Compass, the Analogue 
Compass is not as sensitive to the external 
magnetic environment and cannot be calibrated 
before use. 
 
The Analogue Compass can be quickly installed 
and removed on the Artemis frame, and 
secured using the two thumb-screws on either 
side of the module. 
 

 

As the Analogue Compass is mechanical and 
contains a magnet, using the Analogue 
Compass module at the same time as the 
Digital Compass will introduce a directional 
error onto the digital reading.  
 
When using the Digital Compass for 
navigation, the Analogue Compass module 
should be removed from the Artemis 
frame. 

  

 3.7.2 Digital (Magnetometer) Compass 
The Digital Compass is located within the Artemis Console and is used by the 
navigation system to determine the diver’s current heading and bearing to swim values 
that are displayed on the screen. 
 
The compass is extremely sensitive to surrounding magnetic fields and may need 
calibrating before use depending on the background magnetic signature at differing 
geographic locations. 
For further information on calibrating the digital compass see section 4.8 on page 30. 

 

 

Based around a magneto-resistive magnetometer sensor, the Digital Compass exhibits 
no magnetic signature (unlike the Analogue Compass) making it ideal for use in 
environments that are magnetically sensitive or where a fast update rate and high-
accuracy are required. 
 

 

When using the Digital Compass for navigation, the Analogue Compass 
module should be removed from the Artemis frame. 
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3.8 Attaching the GPS Skid 
For navigation, Artemis is supplied with a GPS float, 40m tether and cable 
management skid. 
 
To attach the skid to the main frame… 
 
 First slide the locating lugs at the rear of the Artemis frame into the hook recesses 

at the rear of the skid 

 Lower the front of the Artemis frame down onto the GPS skid so the attachment 
boss engages with the frame. 

 Secure the skid by inserting the Locking Pin into the small hole at the front of the 
frame (beneath the sonar). 

 

 
 
 Once the skid is secure, remove the blanking plug from Serial Port 2 on the Artemis 

console (see section 3.6 on page 14). 

 Firmly push the GPS Skid’s electrical plug into Serial Port 2 (see note below) on the 
Artemis console and ensure that the connector pins are not exposed to water. 

 On power up, the GPS status icon ( ) should turn yellow while a fix is being 
acquired, then green when a position is obtained. If this does not occur, ensure the 
GPS power is enabled in the “Power Application” (see section 4.1.3), and check the 
GPS diagnostics display (see section 4.4.3). 

 

 

By default Serial Port 2 is configured as the GPS port, although settings are available in 
the “Settings Application” (see section 4.4.4) to allow this to be swapped to Serial 
Ports 1 or 3. 

 

When removing the GPS skid, reverse the above procedure and ensure the blanking 
plug has been replaced in Serial Port 2 to prevent damage to the electrical contacts by 
salt-water. 

 
3.9 Attaching the GPS Training Float 
If using the large orange ‘training float’ (supplied as an optional extra), then the float 
should be secured to the Artemis frame by means of the plastic boss and locking pin 
that are attached to the float’s cable. 

 

Do not rely on the GPS Float connector plug as the only means of securing the 
Training Float to Artemis. 
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3.10 Connecting the USB Lead 
To upload new “Mission” files onto Artemis, or download recorded “Dive Log” data, use 
the USB lead connect the Artemis display to a PC… 
 
 Power down Artemis, and plug the USB lead into the USB connector at the base of 

the console.  

 Connect the other end of the lead into a free USB socket on a PC / Laptop that has 
the “Artemis Manager” software installed. 

 Turn Artemis on and after a short time the Windows™ operating system should 
detect Artemis, and appear as a “Mass Storage Device” (similar to a USB pen-
drive).  

 Use the Windows File Explorer (or other file manager) to copy any Mission files onto 
the internal flash storage of the Artemis Display, or download and remove any Dive 
Log files. 

 

 

Please note that on some systems, the USB detection time can take up to several 
minutes if the computer needs to find and download the appropriate Mass Storage 
Device drivers from Microsoft. 
 

 

To prevent corruption to any of the files, always follow the “Safely Remove 
Hardware & Eject Media” procedure required for the Windows operating 
system being used, before disconnecting the USB cable or powering-down 
Artemis. 
 

 

For further details on working with Artemis Mission and Dive Log files, please refer to 
section “Mission & Dive Log Files” on page 32. 



 

18 

4 USING ARTEMIS 

 
4.1 Turning Power On & Off 
Before powering up, ensure that a charged battery has been properly connected to the 
display unit as described in the previous sections. 
 

 

 

4.1.1 Powering Up 
 When Artemis is powered down, the unit may be turned on by a single press to the 

central “Power/App” button.  

 After a few seconds, the Artemis welcome screen will appear and the unit is ready 
for use. 

 

 

4.1.2 Powering Down 
 When the unit is turned on, repeatedly press the “Power/App” button to cycle 

through the applications until the “Power Application” appears… 

 
 

 Press any button to enter the application… 

 

 
 Press “F1/Up” to choose “Power OFF” 

 
The use of Artemis “Applications” is discussed further in subsequent sections. 

 4.1.3 Sensor Power (GPS & Sonar)  
To save battery life during a mission, power to the two sensor serial ports can be 
switched on or off from the “Power Application”. 
By default, when Artemis powers up, power to both Serial Ports is also turned on. To 
switch off an external sensor, enter the Power Application (as described above), then 
select F3/LEFT or F4/RIGHT to toggle power to Serial Ports 1 and 2 respectively. 
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4.2 Display Status Bar  
When Artemis is power up, regardless of the current application display, the bottom 
strip of the screen will always show the Status Bar. 
 
The Status Bar is split into 4 parts… 
 

 
 
 Hardware Status Icons – These icons show the current status of the battery, 

sonar, GPS, dive-log and immersion sensor. The icons change colour to indicate 
state where green indicates OK, yellow is a warning condition and red indicates 
error or disabled. Generally during a dive all the status icons should be green. 

 Navigation Bubble – The Navigation Bubble part of the display is only used when 
the diver has selected a Mission file in the Settings Application (see section 4.4.2). 
In the Navigation Application a Mission marker can then be selected, and the 
display will show a graphical representation of the course the diver should swim to 
reach their destination. 

 Magnetic Heading & Depth – The magnetic heading shows the current reading for 
the onboard digital compass, while depth is displayed from the pressure sensor 
reading. 

 

 4.2.1 Battery Status 
The battery status icon will show one of the following states… 
 

 
 Battery capacity greater than 80%. 

 
 Battery capacity greater than 60%. 

 
 Battery capacity greater than 40%. 

 
 Battery capacity greater than 20%. 

 
 Battery capacity greater less than 20%. 

 
(Further detailed battery information is available from the Power Application) 
 

 4.2.2 Sonar Status 
The sonar status icon will show one of the following states… 
(See the Settings Application section 4.4 for details of enabling the sonar.) 
 

 
 Sonar is powered up and scanning correctly. 

 
 Sonar is powered up and initialising. 

 
 Sonar is not powered up. 
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 4.2.3 GPS Status 

The GPS status icon will show one of the following states… 
(See the Settings Application section 4.4 for details of enabling the GPS.) 
 

 
 GPS is powered up and producing position fixes. 

 
 GPS is powered up, but waiting to acquire its first fix. 

 
 GPS is not powered up. 

 
 4.2.4 Dive Logging Status 

The Dive Logging icon will show one of the following states… 
(See the Settings Application section 4.4 for details of manually starting dive logging, if 
the immersion sensor is not enabled.) 
 

 
 The Dive-Log is recording Sonar, GPS, Depth, Attitude and Heading 

information. 

 
 The Dive Log is not recording. 

 

 4.2.5 Immersion Sensor Status 
The Immersion Sensor icon will show one of the following states… 
 

 
 The immersion sensor is wet. 

 
 The immersion sensor is dry. 

 
 If the icon is not shown, the immersion sensor has been disabled in the 

Settings Application.  

 4.2.6 Magnetic Heading & Depth 
The magnetic heading will display the current measurement taken from the onboard 
digital compass, while depth is calculated from the pressure sensor reading. 
 
The compass sensor may be affected by the presence of ferrous materials (or magnetic 
fields) around Artemis and a calibration may need to be performed – see section 4.8 
for further details on this procedure. 
 

 4.2.7 Navigation Bubble 
The Navigation Bubble (or Navigation Aid) is only used when a Mission file has been 
selected for use in the Settings Application (see section 4.4.2), and a target selected in 
the Navigation Application (see section 4.6). 
 
Depending on the course the diver needs to swim to reach the target marker, the 
display will show one of the following symbol combinations… 
 

 
 Target is more than 90° to left or right 

 
 Target is more than 60° to left or right 

 
 Target is more than 30° to left or right 

 

Target within ±30°. Turn to align the dot in centre of display for the 
correct course. The colour of the dot will match that of the selected 
navigation marker. 
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4.3 Choosing a Display (Application)  
Once Artemis is powered on, it can perform several tasks to aid the diver, including 
showing sonar information, navigational position, distance and bearing to a selected 
target and data logging. 
 
To achieve this, Artmeis runs several software applications, or “Apps” (similar to 
modern smart-phones). Each application has its own visual display, and different 
functions for the four navigation/function buttons on the keypad. 
 
The applications currently installed on Artemis are… 
 

 

Power 
Allows control of power to the attached peripherals (Sonar and GPS), and 
shuts down Artemis. 
 

 

Settings 
Provides a menu interface to allow system settings to be adjusted, including 
screen brightness, date and time and hardware setup. 
Additional GPS diagnostic information and system information can be 
displayed. 
 

 

Sonar 
Shows the imagery collected by the sonar, and allows the range and gain 
settings to be controlled by the function keys. 
 

 

Navigation 
Shows a chart containing pre-defined ‘mission’ targets and waypoints, the 
diver’s position and previous route. The functions keys allow selection of 
navigation destinations, chart zoom levels and further targets to be marked. 
 

 

Dive Profile 
Shows a recent history of the depth sensor plus additional information on the 
dive duration and current diver depth. 

  

 
 

 

To choose an application… 
 
 First press the “Power/App” button to show the application switcher display. 

 Repeated presses of the “Power/App” button will cycle through the list of available 
Apps, in the order shown below… 

 

 
 

 

 When the icon for the desired application is shown, press any of the other four 
function buttons to select and switch to its display. 

 

 

In addition to the title, the Application switcher display shows the actions performed by 
the four function buttons within the application, along the bottom of the screen. 



 

22 

 
 

4.4 Settings Application 
The Settings Application allows the diver to control the Artemis operational 
parameters. 
 

 
 
When the Settings Application is active, the console buttons have the following 
functions… 
 

 
Move Selection Up 

 
Previous Value / Execute 

 
Move Selection Down 

 
Next Value / Execute 

 
By moving the Selection cursor Up and Down the list, the Diver may choose a 
parameter to alter (or sub-menu to enter). 
Pressing the Left or Right keys will then cycle through a list of values for the current 
parameter, or execute the function selected (such as Start Logging or enter a sub-
menu). 
 

4.4.1 Settings 
The top level of the settings list contains the following items… 
 Start / Stop Logging – Manually starts or stops a dive (normally the Immersion 

sensor would do this if enabled). When a Dive is started, the depth sensor is 
zeroed, and recording of a dive log starts. 

 Mission – Chooses the current mission file the Navigation Application should use, 
see section 4.4.2 below for further details. 

 Show Compass – Displays a screen just showing compass information. 

 Show GPS – Displays a screen showing the current state of the GPS receiver, and 
the satellite availability currently being used to compute its fix. See section 4.4.3 
below for further details. 

 System Settings – contains controls to allow the real-time-clock to be set, and 
hardware configuration selected. See section 4.4.4 below. 

 About – Displays a list of system settings, including the serial number of the unit 
and the version numbers for its hardware and firmware. See section 4.4.5 below. 
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 4.4.2 Mission Selection 

The Mission setting allows the diver to cycle through a list of available “.mission” files 
on the Artemis storage. These files are created using the “Artemis Manager” software 
(see section 5.5) and copied onto Artemis’ internal storage via the USB lead (see 
section 3.10). 
 
When a mission file has been selected in the Settings Application, cycling to the 
Navigation application will show the markers and waypoints contained in the file… 
 

 
 
If no mission file is required, the “No Mission” option can be selected in the settings. 
 

 4.4.3 GPS Diagnostics 
When the GPS is connected (and enabled 
in the System Settings menu), the “Show 
GPS” settings option will show the GPS 
diagnostic display.  
 
This shows the current state of the GPS, 
including the availability of satellites, their 
signal strengths and the current GPS 
position fix. 

 

 After connecting and powering up the GPS, it can take several minutes for the GPS 
receiver to get it first fix. During this time, the GPS status icon ( ) will be yellow, and 
once a fix has been acquired the icon will change to green. 
 
The connection status indicator ( ) at the top left of the display will rotate through 
90° every time Artemis receives a GPS data message, regardless of a fix being 
available. This can be used to verify the receiver is connected and powered up. 
 
The main part of the display shows a polar graph representing the overhead 
hemisphere of the sky with the numbers of available GPS satellites in their current 
positions. To the right of the display a series of bar-graphs shows the signal strength 
available form each satellite. 
 

 

Satellites whose signal is too weak to receive are shown in red, while satellites whose 
information is not being used in the current fix are shown in green. Satellites that are 
being used in the fix solution are shown in white. 
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4.4.4 System Settings 
The “System Settings” menu allows the 
user to adjust the hardware setup of 
Artemis. 
 Language – Allows the user interface 

language to be changed. 

Brightness 
Shortcut 

 
 

 Brightness - The display brightness 
can be adjusted through 3 settings : 
Low, Medium and High. 
Simultaneously pressing the F1/Up 
and F4/Right keys will toggle 
between the current brightness and 
Low brightness. 

 

  Date and Time – The clock is used for dive logging, and will be stored in the 
internal battery backed up clock. 

 Serial Port - The device attached to each serial port can be selected from a list of 
available hardware (None, Sonar or GPS). If these settings are incorrect for the 
attached hardware peripherals, they will not detect correctly and the 
corresponding status bar icon will remain red. 

Data 
Scuttle 

Shortcut 
 

 

 Data Scuttle – Setting this option “On” enables the Data Scuttle feature, which 
will erase all mission and dive-log data from Artemis’ internal storage when the 
Diver presses the F3/Left and F4/Right keys simultaneously. 

 

 4.4.5 System Information 
The “About” settings option will show 
information about Artemis’ current 
configuration. 
 
Please have this information to hand if 
contacting Artemis Technical Support. 
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4.5 Sonar Application 
The Sonar Application shows a polar (top-down) image of acoustic echoes transmitted 
and received by the sonar and varying angles as its scans across its 90° field of vision 
in front of the diver. 
 

 
  

 

See the section 7 “Understanding Sonar Imagery” on page 60 for further details of how 
to interpret the sonar display and get the best performance from the range and gain 
controls. 

  
When the Sonar Application is active, the console buttons have the following 
functions… 

 

Range Up 
Increases the range scale on the sonar display. 

 

Range Down 
Decreases the range scale on the sonar display. 

 

Gain Down 
Decreases the sonar gain – image intensity will be reduced and finer detail 
seen on closer targets. 

 

Gain Up 
Increases the sonar gain – fainter targets will appear brighter. 

 

4.5.1 Gain 
The current sonar gain is shown at the bottom right of the display as a percentage. 
Increasing the gain will amplify fainter echoes making the entire display appear 
brighter (and possibly saturate some target detail), while decreasing the gain will dim 
the display (possibly hiding fainter targets, but making it possible to detect texture and 
detail on others). 
 

4.5.2 Range 
The sonar range is shown at the bottom left of the display, and represents the 
maximum range the display is showing.  
At larger ranges, the sonar scan rate will slow, as it must to wait longer to collect the 
received echoes from targets, while lower ranges will increase scanning speed. 
 

4.5.3 Heading and Depth 
To assist in location, search and rescue tasks, the current magnetic heading and depth 
sensor readings are shown at the top of the display.  
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4.6 Navigation Application 
The Navigation Application uses data from the external GPS Float, and the internal 
compass to provide navigation information to the diver. 
 

 
 
Before a dive commences, the Artemis Manager PC software should be used to create a 
Mission File that is uploaded onto Artemis via the USB cable, and then selected as the 
current mission file to use from the Settings Application. 
 
The Mission File defines a series of “Markers” that have their geographical locations 
shown on the display. Marker locations may be entered in the Artemis Manager 
software or imported from third-party software (such as Google Earth TM™ KML data). 
For flexibility, the Diver and Supervisor may pre-agree on the styles and colours of 
markers to be used and what they represent. 
 
The Navigation display shows a scalable chart of the diver’s position and mission 
markers. The charts grid spacing is shown at the top left of the display, and currently 
selected marker name at the top right. 
 
The two large numbers at the bottom of the display are calculated from the current 
GPS position and show the divers distance and course-to-swim to the selected marker. 
 
The magnetic compass heading and Navigation Bubble are shown in the Status Bar at 
the bottom of the display (see section 4.2.7 for more information). 
 

 

For further information on creating Mission Files, please refer to the Artemis Manager 
“Mission File Editor” section on page 35. 

 When the Navigation Application is active, the console buttons have the following 
functions… 
 

 

Mark Target 
Pressing this key will add a “Diver Marker” to the mission file at the divers’ 
current location. 
In total the Mission File can support 20 markers, but must contain spare 
capacity to allow the marker to be added. 

 

Next Target 
Pressing this key will sequentially cycle through the list of defined markers, 
selecting each one in turn as the current navigation destination. 

 

Zoom 
This key cycles through a list of chart scales, from “Show All”, progressively 
zooming into the display. 

 

Display Mode 
This key selects whether the display is shown in Cartesian “North Up” or 
Polar “Diver Heading Up” modes. 
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With a mission file selected, the display may show the following symbols… 
 

 

Diver 
This symbol represents the position of the diver, and rotates to show his 
heading (relative to North at the top of the display). 

 
Waypoint Marker 
A style of marker that defines a navigational path the diver may take if 
doing area search work. 

 
Target Marker 
A marker indicating a target or point of interest to visit or investigate. 

 
Diver Placed Marker 
A marker that has been placed by the diver during a dive. 

 

Once a Mission File has been selected, pressing the F2/Down  ( ) key will cycle 
through the missions list of Markers, selecting each on in turn as the Destination, and 
showing its name in the top right corner of the display.  
 
The destination marker will be highlighted with a white outline on the display, and an 
interconnecting line. In addition, the ‘range to marker’ is shown at the bottom left of 
the display, and ‘bearing to marker’ at the bottom right. 
 

4.6.1 Using the Navigation Application 

 

 

The first stage when using the Artemis 
Navigation function is to create a 
‘.mission’ file using Artemis Manager. 
This should contain markers for any 
waypoints or targets of interest the diver 
wishes to locate. 
 
The ‘.mission’ file should be copied onto 
Artemis’ internal storage via the USB lead. 
 
In the Settings Application, select the 
name of the mission file for the Navigation 
display to use. 
 

 

 
 

Ensure the GPS is connected, enabled in 
hardware settings and receiving a fix (use 
the GPS diagnostics display if necessary). 
 
Switching to the Navigation display shows 
the mission markers relative to the diver 
(at the centre of the display). 
 
Press F4/Right to toggle the display 
mode between a Cartesian grid and Polar 
rings with either North Up or Diver-
Heading Up. 
 

 At this point the diver is not in the water, so the Immersion sensor has not activated 
logging and the “disk” status icon is red.  
 
When the diver submerges the dive logging will begin and the “disk icon becomes 
green. If the Immersion sensor has been disabled (in the hardware settings), then 
“Start Logging” must be manually selected in the Settings. 
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The figure to the left shows the diver has 
used pressed F2/Down to cycle through 
the markers until “Waypoint1” is selected, 
and has pressed F3/Left to increase the 
chart scale to 5m per grid division. 
 
Their current magnetic heading is 345°, 
shown in the status bar). 
The two large numbers at the bottom of 
the display indicate they area 16.6m from 
the marker, and it lies 30° to their right. 
 
In the status bar, the “bubble” display 
shows graphically the heading they should 
swim. As the diver rotates towards the 
marker, the “bubble” will move left across 
the status bar until it aligns with the 
datum markers in the centre. 
 

 

 
 

As the dive progresses, a “snail trail” 
(limited to approximately 1 hour) will be 
displayed behind the diver showing the 
course they have covered. 
 
The figure to the left shows the diver 
navigated towards “Waypoint1”, then 
“Waypoint2” before selecting “Target2”. 
 
The large numbers at the bottom of the 
display show that it lies 33.6m in front of 
them and 3° to their right – this is also 
confirmed by the yellow “bubble” 
(matching the marker colour) being 
almost central on the status bar. 
 

 

 
 

Finally in this dive, the diver has inspected 
“Target2” and is currently by “Target3”.  
 
As the mission was created with an “Entry 
Point” marker, they have selected this and 
navigation information is displayed at the 
bottom of the screen showing the course 
they must take to return to their point of 
entry. 
 
The destination is more than ±30° away 
from their current heading, so the status 
bar “bubble” has been replaced with a 
serial of arrows showing they must turn 
through at least 90° to their right (where 
each arrow represents a 30° increment). 
 

 4.6.2 Marking Targets 
During a dive, the pressing F1/Up will add a marker to the mission file at the divers 
current location. The marker is entered as a “diver marker” (  ) so its graphical 
symbol differs from that of a “waypoint” (  ) or “target marker” (  ) simplifying 
post-mission dive-log analysis when using the Artemis Manager software. 
 
In total, a mission file can up to 20 markers and this includes diver placed markers. 
Once the mission file marker list is full, no further diver placed markers can be added. 
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4.7 Dive Profile Application 
The Dive Profile application shows the recent history of the depth sensor, along with 
the current depth reading and the duration of the dive (since the dive was started by 
the immersion sensor, or manually selecting “Start Dive” from the settings screen). 
 

 
 

 
When the Dive Profile Application is active, the console buttons have the following 
functions… 
 

 
Zero Depth 

 
Not used 

 
Not used 

 
Not used 

 
 

4.7.1 Resetting the Depth Sensor 
Pressing F1/Up on the Depth display will reset the depth sensor reading to zero for the 
divers current depth. Consequently, this function should only be performed at the 
surface by the diver if the depth sensor isn’t reading zero. 
 
However, if the Immersion Sensor is enabled (see Settings application), then the depth 
sensor will be automatically set to zero when an immersion is detected and a new dive-
log is started. 
Manually starting logging (from the Settings application) will not reset the depth sensor 
automatically. 
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4.8 Calibrating the Compass 
The Artemis digital compass uses three magnetic sensor elements (one on each axis) 
to measure the surrounding magnetic field and determine the direction or Magnetic 
North. 
However, the presence of ferrous material or changes in the magnetic environment 
around Artemis may cause an error to be present in the compass heading displayed, 
indicating that the sensors should be recalibrated.  
 
To calibrate the compass… 
 
 Switch to the Settings Application. 

 Choose the “Show Compass” option to bring up the Compass Display. 

 Press the F1/Up button to start the calibration procedure. 

 Follow the instructions on the display to work through the calibration procedure and 
calibrate the compass. 

 

 

During calibration, you will be required to rotate Artemis around its three axis (pitch, 
roll and yaw). It helps if you imagine Artemis being inside a sphere, and during 
rotation the front of Artemis is painting the inside of the sphere as you move it around. 
 
The aim is to rotate and roll Artemis through as many orientations as possible in three-
dimensional space, and as you do so the compass is attempting to measure the 
magnetic field for each orientation. 
 
The figures below give an indication as to the types of movements you should make 
around the axis, and this should be done in a variety if different orientations (i.e. 
holding Artemis horizontally, vertically, upside down etc)… 
 



 

31 

 
 

4.9 Updating Firmware 
Occasionally a new version of the Artemis firmware (software that is run on the Artemis 
Console) will be released, to fix bugs or add new functionality. The firmware can be 
updated in the field, without needing to return the unit to the factory. 
 
The current firmware version can be obtained by switching to the “Settings 
Application”, and selection the “About” option in the list. 
 
 
To update the firmware… 
 
 Ensure you have the new “firmware.bin” file accessible on your computer. 

  With Artemis turned off, connect the console to the PC via the USB cable. 

 
 Turn Artemis on by pressing the power button. 

  Artemis should connect to the PC and appear as a USB “Mass Storage Device” in 
Windows File Explorer. 

 When Artemis is detected by Windows, open a File Explorer and copy the new 
“firmware.bin” file into the root of Artemis’ storage (do not change the filename). 

 When the file has copied, to prevent corruption to any of the files follow the “Safely 
Remove Hardware & Eject Media” procedure required for the Windows operating 
system being used, to disconnect the Artemis Mass Storage Device. 

 When Windows shows the “It is now safe to disconnect your hardware” notification 
change to the “Power Application” and power down Artemis. 

 Disconnect the USB lead from the Artemis console. 

 Press the power button again to turn Artemis back on. After a few seconds the 
screen should display “Updating Firmware”.  

 Please wait for approximately 10 to 20 seconds for this process to complete. 

 When done, Artemis should continue to its main display using the new firmware 
(the new firmware version number can be checked by changing to the “Settings 
Application” and selecting “About”). 

 If the firmware update has been successfully, Artemis will remove the 
“firmware.bin” file from its storage. 

 

 

DO NOT FORMAT the Flash storage as this will delete factory entered 
hardware-specific calibration data stored in hidden system files, and lead to 
erroneous sensor readings until new calibration data can be entered. 
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5 USING ARTEMIS MANAGER 

 
 

 

5.1 Mission & Dive Log Files 
“Artemis Manager” is a PC Windows software application that is used pre-dive to 
configure the Artemis console with geographical locations (navigational waypoints and 
targets of interest), and post-dive to review data collected by the sonar, and review 
the route taken by the diver along with additional targets marked during the dive. 
 
Artemis Manager provides the user with two distinct functions… 
 

 

Mission Files 
Mission files are created prior to diving with Artemis, and copied onto its internal 
memory via the supplied USB cable. 
 
The “Navigation Application” on the Artemis console reads the mission file, and 
displays a geographical chart showing the marked navigational waypoints and targets 
of interest for the dive.  
 
During the dive, the diver can select a marker from the mission file and the Artemis 
Navigation System will then use position data (from the GPS float) to provide real-time 
distance and bearing information, helping to navigate them to the target. 
 
The Artemis Manager application provides several methods for importing (and 
exporting) position information for the markers, including CSV (Comma Separated 
Variable) files and KML files (used by applications like Google Earth™). 
 

 

Dive Log Files 
During the dive, Artemis will collect and record all the sensor information received from 
the Sonar, GPS float, internal compass and depth sensor, into a ‘dive log’ file. 
 
Once the dive is complete, the log file can be copied onto a PC running the Artemis 
Manager software application, and played back to allow the sonar data to be reviewed 
along side the diver position and heading when it was recorded. 
 
Artemis Manager provides several data export functions, allowing the sensor data to be 
processed by other third-party applications (such as Tritech SeaNet, Google Earth™ 
and spreadsheet applications), as well as creating new mission files from the dive 
including any additional diver-placed position markers. 
  
 

 
5.2 Installing Artemis Manager 
From CD 
 Insert the CD supplied with the Artemis system into the CD-ROM drive of PC 

running Microsoft Windows. 

 If the CD does not auto-run, run the “ArtemisSetup.exe” file found on it. 

 When the Install Wizard starts, follow the on-screen instructions to complete the 
install, and place shortcuts to it on the Desktop and in the Start Menu. 

 
From the Internet 
 Visit the www.blueprintsubsea.com/artemis/support.php software support web 

page to download the latest version of “Artemis Manager”; then run it when 
complete. 

 When the Install Wizard starts, follow the on-screen instructions to complete the 
install, and place shortcuts to it on the Desktop and in the Start Menu. 

http://www.blueprintsubsea.com/artemis/support.php�
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5.3 Getting Started 

 

When “Artemis Manager” application starts, it will show the “Files” screen… 
 

 
 

 
As discussed in the previous section, Artemis Manager has two distinct roles; Mission 
Editor and Dive Log Viewer. 
 
The options available allow the operator to quickly perform the most commonly used 
tasks… 
 

 

New Mission 
Click this button to quickly jump to the “Mission Editor” and start working on a new 
mission file. See the “Mission Files” section below for further details. 
 

 

Open Mission 
This button opens an existing Mission File in the “Mission Editor”. See the “Mission 
Files” section below for further details. 
 

 

Open Dive Log 
This button opens a recorded log file in the “Dive Log Viewer” to allow data to be 
reviewed and exported. See the “Dive Log Files” section below for further details. 
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5.4 Settings & Options 

 

From the “Files” page, click the 
“Settings” button to show a window 
where program settings and 
preferences can be adjusted 

 

 

 

Angular Measurements 
The angular measurements drop-down list allows you to select the style that latitude 
and longitude values will be shown as. Available formats include… 

  Signed Degrees 

 Signed Degrees & Minutes 

 Signed Degrees, Minutes & Seconds 

 Signed Degrees, Minutes, Seconds 
and Milliseconds 

Examples… 
-54.241819° N 
-54° 14.509' N 
-54° 14' 30" N 
-54° 14' 30.547" N 

 

  Unsigned Degrees 

 Unsigned Degrees & Minutes 

 Unsigned Degrees, Minutes & Seconds

 Unsigned Degrees, Minutes, Seconds 
and Milliseconds 

Examples… 
54.241819° S 
54° 14.509' S 
54° 14' 30" S 
54° 14' 30.547" S 

 

 

Distance Measurements 
The distance measurements drop-down list allows you to select the units that distance 
values will be shown in. A variety of metric and imperial units are available, 
including… 
 Meters (m) 

 Feet (ft) 

 Inches (in) 

 Fathoms (ftm) 

 Chart Data Resolution 
When Dive-Log data is loaded into Artemis Manager this settings determine the time 
interval at which data points on the display are created (for the Navigation Path and 
Dive Profile displays). 
 
Selecting a smaller time interval will create higher resolution paths and allow the 
mouse point to show data to a finer time resolution at the expense of memory and 
possibly slowing the PC’s performance on larger Dive-Log files. 
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5.5 Mission File Editor 

 

Show the “Mission File Editor” by clicking the Missions tab at the top of the Artemis 
Manager screen.  
 
When a Mission File is open, then screen will look similar to the example below… 
 

 
 

5.5.1 Mission File Actions 
Use the actions listed down the left side of the screen to open, close and save Mission 
files… 
 

 

New Mission 
Closes any currently open mission file, and creates a new blank mission. 

 

Open Mission 
Loads a previously created (or exported from a Dive Log) mission file for review or 
editing. 

 

Save Mission 
Save any changes made to a Mission file back to disk. 

 

Close Mission 
Closes the currently open Mission file, prompting to save any changes in necessary. 



 

36 

 
 5.5.2 Adding & Removing Navigation Markers 

Navigation markers (up to a maximum of 20) can be added to the mission by clicking 
the “Add Marker” button. Once added, click on grid row to edit marker values. 
 
To remove a marker, click its grid row then click the “Remove Marker” button. 
 

 

Artemis can handle up to 20 mission markers in total, and this includes any placed by 
the diver during the dive. If the mission file has all 20 markers defined, there will be no 
spare capacity for the diver to add any additional markers. 
 

 Name 
Each marker can have a name (up to 12 characters). This will be shown for the 
selected target on the Artemis navigation display. 
 
Type & Colour 
Each marker can be one of 3 types… 

  Waypoint – waypoints are used to specify a search path/pattern and can be either 
dark or light gray in colour. Optionally, connecting lines can be shown on the 
Artemis display to assist the diver navigating the path. 

  Target  – targets should be used to specify points of interest that the diver may 
wish to navigate to or be aware of. A choice of Red, Yellow, Green, Blue and Purple 
colours are available for target markers. 

  Diver - any markers placed during the dive are specified as “Diver” type to 
distinguish them from the pre-dive “Targets”. 

 

 Latitude, Longitude & Depth 
Enter the position and depth of the marker in these fields. When the marker is selected 
as the destination on the Artemis navigation display, heading and distance will be given 
based on the divers current position (from the GPS float). 
 

 

The format of the “latitude”, “longitude” and units of the “depth” values can be selected 
in the “Options” window – see the “Settings & Options” section on page 34 for further 
details. 
 
 
 

 5.5.3 Organising Navigation Markers 
The order of the mission markers in the on-screen table is the order they will be 
presented to the diver on the Artemis console, and the order they are cycled through. 
 
To re-order the list, click the row the required marker to move is on, then use the 
“Move Up” and “Move Down” buttons to reposition appropriately. 
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 5.5.4 Navigation Display Options 

The navigation display options control the appearance of information on the Artemis 
console during the dive. 
 
Diver Colour 
Use these buttons to choose the colour the diver (and trail) is represented as. 
Depending on the marker colours chosen, you may wish to choose a contrasting colour. 
By default red is selected. 
 
Extend Diver Heading 
Tick this option to show a “heading line” extending out from the diver icon. The 
heading line can assist the diver in determining if they are on the correct course. 
 
Connect Waypoints 
Tick this option to draw interconnecting gray lines between the defined Waypoint 
markers in the mission file. This is useful if waypoints have been entered to define a 
search pattern or path that should be followed. 
 
 
 

 5.5.5 Importing & Exporting Mission Data 

 

Import KML Markers 
As an alternative to entering mission navigational markers manually in the Mission 
Editor, third-party programs (such as Google Earth™) allow them to be graphically 
placed and saved to a KML file. 
Choose this option to import any place-marks defined in a KML file as mission markers. 
 

 

Export KML Markers 
Exporting the mission markers to a KML file allows them to be opened and graphically 
edited in third-party programs (such as Google Earth™). 
 

 

Export CSV Markers 
The option exports the markers defined in the mission file, as a list of Comma 
Separated Variables (CSV), which can be opened and manipulated in spreadsheet 
applications. 
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5.6 Dive Log Viewer 

 

Show the “Dive Log Viewer” by clicking the Dive Logs tab at the top of the Artemis 
Manager screen.  
 
When a Dive Log is open, then screen may look similar to the example below… 
 

 
 
The screen is split into several sections; file actions and tools are listed down the left 
side, displays for sensor data occupy the main central area, and log replay controls are 
shown along the bottom. 
 

5.6.1 Dive Log Actions 
Use the actions listed down the left side of the screen to open, close and save Mission 
files… 
 

 

Open Log 
Loads a log file recorded during a dive. In addition to depth, heading, and other 
integrated sensor data, the sonar data and GPS position are also recorded if those 
sensors are connected. Once opened, the Dive Log viewer can review or export the 
data to another application. 
 

 

Close Log 
Closes the currently open Dive Log file. 
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 5.6.2 Exporting Data 

 
 
 

 
 

 
 
 

Once the dive log has been opened, you can export its data to a variety of third party 
programs. 
 
Click the expander button to the right of the “Export Data” tool, to show a popup list of 
file types that can be exported.  
 
To export an individual file, click the file heading. Alternately, each file type has a tick-
box next to it – select files to export in a batch operation, then click the “Export Data” 
button to export all files at the same time. 
 
For convenience, your selections are remembered when Artemis Manager is opened, so 
once configured log files can be quickly exported to other programs. 
 
Available export types are… 
 
Tritech Seanet Sonar File 
Exports a Seanet logfile (“.v4log” extension) which can be opened in Tritech’s Seanet 
application to review the sonar data, take measurements etc. 
 
Artemis Mission File 
Exports a new mission file that combines the mission file used to create the Dive Log, 
along with any additional markers placed by the diver during the dive. 
 
KML Data 
Exports the mission markers, diver markers and the path the diver took to a KML 
places file that can be loaded into graphical viewer applications such as Google Earth™. 
 
CSV Data 
Exports the mission markers, diver markers, path data, depth profile, battery voltage 
etc., into a series of Comma Separated Variable (CSV) files that can then be loaded 
into external applications and spreadsheets. 
 

 5.6.3 Log Playback 
When a Dive Log has been opened, its can be played back in the Dive Log viewer using 
the following controls, location along the bottom of the display… 
 
Position Slider 
In the bottom right corner of the display, the position slider shows and sets the current 
position in the log file. Drag the slider to reposition the playback location. 

 

Play 
Click the play button to start log file playback. 

 

Pause 
Click the pause button to stop log file playback. 

 

Restart 
Move the playback position back to the start of the logfile. 

 

Repeat 
Toggles whether the log file stops playing when the end is reached, or automatically 
restarts from the beginning again. 

  
Playback Speed 
The “x1”, “x2”, “x4” and “x8” buttons controls the speed of the log file playback. For 
real-time playback (i.e. the speed the data was recorded at), select “x1”. 
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 5.6.4 Navigation Display 

The navigation display shows the route the diver took (as recorded by the GPS float), 
along with defined mission markers and diver placed markers. 
 
Moving the log position slider will move the diver along the track, and show the route 
covered as a solid line.  
The diver arrow graphic shows the divers heading as recorded by the Artemis compass. 
 
The following controls and tools are available for the Navigation Display… 
 

 

Pan 
Choose this option, then drag the display with the left-mouse-button, to move the 
viewable area around. 
 

 

Measure 
Chose this option, then drag from one point to another on the navigation display, to 
measure distance and heading. Cursor information is shown on the left side of the 
screen. 
 

 

Zoom To Area 
Choose this option, then drag a rectangular area on the navigation display to zoom in 
to it. 
 

 

Zoom In 
Zooms the navigation display in one scale level. 

 

Zoom Out 
Zooms the navigation display out one scale level. 

 

Zoom All 
Sets the display zoom level to show all mission markers, and the entire route taken by 
the diver. 

 
 5.6.5 Depth Display 

The depth display shows the depth profile recorded for the entire dive. Moving the log 
position slider will move the cursor along the display so the depth data can be related 
to the sonar and navigation displays. 
 
Markers placed by the diver during the dive are shown as vertical dotted lines at the 
time index they were placed. 

 5.6.6 Sonar Display 
The sonar display shows imagery recorded by the forward looking sonar. For further 
details on using the sonar and its imagery, refer to the section “Understanding Sonar 
Imagery” on page 60. 
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5.7 Entering Mission Marker Coordinates 

 In addition to importing markers from external sources (such as Google Earth), Mission 
File markers can be entered manually from geographic positions. However, there are 
several formats that positions can be expressed in and this section looks at how 
Artemis Manager handles these… 
 

 5.7.1 Definitions 
The terms “Latitude” and “Longitude” define values of a geographic coordinate system 
for positions on the surface of a sphere such as the Earth. 
 
 Latitude is the north/south angle between a point on the surface of the Earth and 

the equatorial plane, where a straight line that passes through the point and is 
normal to the surface of the Earth. Latitudes can lie between -90° (or 90° South) to 
+90° (or 90° North), where 0° lies on the equator. 

 Longitude is the east/west angle between a point on the surface of the Earth and 
the reference meridian that goes from the North Pole to the South Pole. Longitudes 
can lie between -180° (or 180° West) to +180° (or 180° East)1. 

 
Latitude and Longitude geographic coordinate values represent the value of an arc, and 
depending on the convention being used can typically be expressed in one of three 
ways… 
 

 Degrees 
Sometimes referred to as “Decimal Degrees”, the value is written as a single number 
with fractional part that describes the coordinate.  
Values in degrees are written with a circular dot symbol ( ° ) after the value. 
 
This is the simplest form of expressing a coordinate but requires a significant number 
of decimal places to describe a location2.  
At the equator (worst case), typically 5 decimal places are required to have a precision 
of approximately 1 metre, while 8 are required for approximately 1 millimetre. 
 

 Degrees and Minutes 
The coordinate is expressed as two fields… 

 The first field contains the whole (integer) number of degrees, and is indicated 
by the circular dot symbol ( ° ). 

 The second field contains the number of minutes with an optional decimal 
fractional component, and is indicated by the single quote symbol ( ' ). 

 
Each minute value represents one sixtieth of a degree (1/60), and so the decimal 
minutes value can be obtained by multiplying the fraction part of a decimal degrees 
value by 60. For example… 

32.76125°  32° 45.675’ (as 0.76125  60 = 45.675) 
 
This notation is sometimes called Degrees and Decimal Minutes, or DM for short. 
 

 Degrees, Minutes and Seconds 
Expanding on the previous form, the coordinate is expressed as three fields… 

 The first field contains the whole (integer) number of degrees, indicated by the 
circular dot symbol ( ° ). 

                                          
1  Values of -180° and +180° describe the same antipodal meridian relative to the 0° “Greenwich” 
meridian. 
2 For further information on precision visit http://en.wikipedia.org/wiki/Decimal_degrees.  
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 The second field contains the whole number of minutes, indicated by the single 
quote symbol ( ' ). 

 The third field contains the number of seconds with an optional decimal 
fractional component, and is indicated by the double quote symbol ( " ). 

 

As with the DM notation above, each minute represents one sixtieth of a degree, but 
additionally each second represents on sixtieth of a minute (or 1/3600 of a degree). 

Values can be converted from decimal degrees by first multiplying the fractional part of 
the degrees value by 60 to obtain the minutes, then multiplying the fractional part of 
the minutes again by 60 to obtain the seconds, For example… 

32.76125°  32° 45.675’  32° 45’ 40.5”  (as 0.675  60 = 40.5) 
 
This notation is sometimes called Degrees, Minutes and Decimal Seconds, or DMS for 
short. 
 

 5.7.2 Signed versus Unsigned 
As discussed above, Latitudes and Longitudes both fundamentally express an angular 
value in degrees, so a ‘sign’ value is used to indicate which hemisphere the coordinate 
lies in.  
 
Convention defines these to be… 
 For Latitudes… 

o Positive values lie in the Northern hemisphere (from 0° to +90°) 

o Negative values lie in the Southern hemisphere (from 0° to -90°) 

 For Longitudes… 

o Positive values lies in the Eastern hemisphere (from 0° to +180°) 

o Negative values lies in the Western hemisphere (from 0° to -180°) 
 
The hemispheres are often abbreviated to the four characters “N”, “S”, “E” and “W” and 
these are written at the end of the coordinate value. 
 
So, for example (ignoring the latitude or longitude context)… 
 32.76125° would be interpreted as either 32.76125° N or 32.76125° E 

 -32.76125° would be interpreted as either 32.76125° S or 32.76125° W 

 
However, this means we can choose to either… 

  Express all values with a positive or negative ‘sign’ and use a North or East 
reference ONLY. 

Artemis Manager refers to this system as SIGNED COORDINATES 

i.e. 32.76125° N and (minus) -32.76125° N 

 Express all values without any sign, and use the appropriate North/South or 
East/West notation 

Artemis Manager refers to this system as UNSIGNED COORDINATES 

i.e. 32.76125° N and 32.76125° S 
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 5.7.3 Choosing the Display Format 

 

You can choose how you want Artemis Manager to display Latitude and Longitude 
coordinate values using the “Settings” button from the toolbar. 
 
When the Settings window appears, the angular measurements drop-down list allows 
you to select the style that latitude and longitude values will be shown in. 
 

 

Regardless of how values are to be displayed, Artemis Manager will accept 
values in ANY of previously discussed formats when creating mission files.  

 

Signed Unsigned Examples of how the different formats are 
displayed are… 

Values are always 
shown in terms of the 
Northern or Eastern 
hemispheres with an 
optional minus sign to 
indicate Southern or 
Western values. 
 

Values are always 
shown without a 
minus sign. Instead a 
“N/S” or “E/W” 
character is used to 
indicate the 
hemisphere. 
 

Degrees Values are expressed 
as Decimal Degrees 
(DD) to 6 decimal 
places. 
 

54.241819° N for 
the northern 
hemisphere  

or 
(minus)  

-54.241819° N for 
the southern 
hemisphere. 

54.241819° N for 
the northern 
hemisphere  

or 
54.241819° S for 

the southern 
hemisphere. 

Degrees & Minutes Values are expressed 
as a whole number of 
degrees and a 
number of minutes 
with a decimal 
fractional part. 
 

54° 14.509' N for 
the northern 
hemisphere  

or 
(minus)  

-54° 14.509' N for 
the southern 
hemisphere. 

54° 14.509' N for 
the northern 
hemisphere  

or 
54° 14.509' S for 

the southern 
hemisphere. 

Degrees, Minutes & 
Seconds 

Values are expressed 
as a whole number of 
degrees, minutes and 
seconds (with no 
fractional part). 
 

54° 14' 30" N for 
the northern 
hemisphere  

or 
(minus)  

-54° 14' 30" N for 
the southern 
hemisphere. 

54° 14' 30" N for 
the northern 
hemisphere  

or 
54° 14' 30" S for the 
southern hemisphere.

Degrees, Minutes, 
Seconds & 
Milliseconds 
 

Values are expressed 
as a whole number of 
degrees and minutes, 
and a number of 
seconds with a 
decimal fraction part 
(to 3 decimal places – 
milliseconds).  
 

54° 14' 30.547" N 
for the northern 

hemisphere  
or 

(minus)  
-54° 14' 30.547" N 

for the southern 
hemisphere. 

54° 14' 30.547" N 
for the northern 

hemisphere  
or 

54° 14' 30.547" S 
for the southern 

hemisphere. 
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 5.7.4 Entering Coordinate Values 

This section covers how to enter Latitude and Longitude coordinates into Artemis 
Manager when creating Mission files. Typically this is required when coordinates have 
been obtained by a third-party or provided by a GPS system. 
 
The common source of confusion when trying to enter coordinates is interpreting their 
format and value compared to that Artemis Manager is currently using to display 
coordinates. 
 
However, it should be noted that regardless of how values are set to be 
displayed, Artemis Manager will accept values in ANY of previously discussed 
formats when creating mission files. 
When the value has been entered, Artemis will then convert it and display it in 
the currently required settings.  
 
This means you can enter values as either just Degrees or Degrees & Minutes, while 
the display setting is Degrees, Minutes and Seconds. Once the value has been entered 
and accepted as valid it will be shown in the DMS format. 
 

 

When entering coordinates as either Latitude or Longitudes, Artemis Manager expects 
up-to three separate numbers to be entered for the value, separated by spaces.  
The last of these numbers may have a decimal point and fractional part. 
 
Any minus sign entered before the sets of numbers will make the value negative and 
specify either the Southern or Western hemispheres. 
Alternately, you may enter a “N”, “S”, “E” or “W” character after the values to specify 
the hemisphere.  
 
For example, all the following values represent the same location and may be entered 
as Latitudes regardless of the current display format Artemis Manager is set to…  
 

  -54.241819 or 54.241819 S Degrees 

  -54 14.509 or 54 14.509 S Degrees & Minutes 

  -54 14 30 or 54 14 30 S Degrees, Minutes & Seconds 

  -54 14 30.547 or 54 14 30.547 S Degrees, Minutes, Seconds & Milliseconds 

  

 

Any other letters, punctuation characters or number fields that you may enter will 
either be ignored or result in a value of zero (0) if they corrupt the meaning of the 
value. 
 
This means that symbols for Degrees (°), Minutes (‘) and Seconds (“) can be optionally 
used if values are being pasted in from another source, but are not critical as it is the 
order of the fields (separated by spaces) that is important. 
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 5.7.5 Troubleshooting Coordinates 

Sometimes coordinate values can be provided in ambiguous forms that hides their 
format. In such cases think about the rules and range limits for Latitudes and 
Longitude to help interpret them, for example… 
 

  54 13 875  Artemis manager would not accept this as the third field is 
seconds and so can only accept values up to 60. 
It is more likely that a decimal place is missing and the value 
should read “54 13.875” indicating a Degrees and decimal 
minutes format. 
 
If entered as a Latitude the value will be in the Northern 
hemisphere, while a Longitude will specify the Eastern 
hemisphere. 
 

  093 42 23.5 This would have to be entered as a Longitude, as Latitude values 
cannot exceed ±90°. 
Artemis manager will ignore any leading zeroes on any of the 
numeric fields. 
 

  4916.45N  

 12311.12W 

Values in this type of format often come directly from GPS NMEA 
serial strings. 
Depending on the value type either the first two of three 
characters should be interpreted as degrees, followed by two 
characters and the decimals as the minutes… 
 
4916.45N represents 49° 16.45’ N and should be entered as “49 
16.45 N”. 
 
12311.12W represents -123° 11.12’ E and could be entered as 
either “123 11.12 W” or “-123 11.12 E”. 
 

 5.7.6 Useful Formula 
A value expressed in Degrees, Minutes and Seconds component form can be converted 
to Decimal Degrees using the following… 

360060
SMDDD   

 
A value expressed as Decimal Degrees (DD) can be converted into its component 
Degrees (D), Minutes (M) and Seconds (S) using the following equations… 

 
 
  60mod3600

60mod60







DDtruncS

DDtruncM
DDtruncD

 

 
Additionally the Decimal Minutes (DM) and Decimal Seconds values can be found by… 

 
  60mod3600

60mod60





DDDS

DDDM
 

 
Where… 

 DD  represents the absolute value of Decimal Degrees. 

  xtrunc  is the truncation function (that removes the fraction part of a value). 

 mod  is the modulo operator, that finds the remainder of a division. 
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5.8 Creating Mission Files using Google Earth 

 As an alternative to manually entering Mission file marker coordinates as values, a 
Mission file can be created by importing KML markers graphically positioned using the 
Google Earth™ application. 
 
In its basic form, Google Earth is a freely downloadable Windows application that 
displays a graphical virtual 3D globe overlaid with high resolution aerial imagery of the 
Earths terrain.  
 
By using mouse and on-screen controls, the user can position and zoom the virtual 
observation “camera” above the site where they wish to create a mission file, and use 
Google Earths tools to graphically position and name markers ready for import into 
Artemis Manager. 
 

 5.8.1 Installing Google Earth 
To create KML files, Google Earth needs to be installed on your computer if not already. 
 
 To download the latest version of Google Earth, open an internet browser and visit 

www.google.com/earth. 

 Follow the links and on-screen instructions to download and install Google Earth 
onto your computer. 

 

 

At the time of writing, the current version of Google Earth was v7.1.2 (found by 
choosing “Help » About Google Earth” from the menu).  
Subsequent software releases may mean some of the screen-shots will differ but the 
basic concepts presented here should remain valid. 
For further details on the use of third-party software applications with Artemis please 
refer to the “Notices” section on page 66 of this manual. 
 

 

Further information on how to use Google Earth, including a comprehensive set of 
tutorials is available on the Google Earth website at the link given above. 
 

 5.8.2 Preparing Google Earth for use 

 Once Google Earth has been successfully installed, it is recommended that several 
configuration changes are made to its default settings. 
 From the menu, choose “Tools » Options”, to show the “Google Earth Options” 

window. 

  In the Options window under the 
“3D View” tab, first choose how 
you want latitude and longitude 
values to appear and distance 
units to be displayed in the “Show 
Lat/Long” and “Units of 
Measurement” group boxes 
respectively. 

 

http://www.google.com/earth/�


 

47 

  For ease of use, it is recommended 
that the auto-tilt while zooming 
feature is disabled.  

 To achieve this, in the Options 
window select the “Navigation” 
tab, and in the “Navigation” group 
box click the “Do not automatically 
tilt while zooming” option. 

 
 5.8.3 Using Google Earth 

In addition to its toolbar and menu bar, the Google Earth display has four main areas 
that the user should be familiar with… 
 

 

 

 Map Area 
The map area shows the 3D view of the earth as if looking through a camera. 
When the mouse pointer is over this area… 
 Holding down the left mouse button and dragging will pan the map around. 

 Rolling the mouse wheel will zoom the map in and out. 

 Holding down the middle mouse button and dragging will tilt the map (NB: This 
function may be sometimes overridden by the Windows mouse settings, and not 
work). 

 

 Map Controls 
The map controls allow the map to be panned, tilted and zoomed, by holding down the 
left mouse button over the relevant control and then dragging the mouse pointer. 
 
A useful feature is to click the “N” icon on the compass to re-align the map view to 
geographic north. 

Map Area

Places 
Panel 

Map 
Controls 

Search 
Panel 
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 Places Panel 
The places panel will be used extensively in this tutorial to manipulate the place 
markers over the targets of interest before being exported to Artemis Manager. 

 
The places panel will show a hierarchical list (or ‘Tree View’) of folders containing place 
markers. 
Right clicking with the mouse will show a pop-up menu that provides actions that can 
be performed on the item in the list, including… 
 Add – This sub menu allows additional place marks and folders to be created. 

 Rename – This option allows place marks to be renamed; the names will be 
exported into Artemis Manager. 

 Save Place As – This option will start the export process, saving the currently 
selected folder/place to a KML file. 

 Properties – This option shows the properties window, and when visible place 
mark positions can be changed by dragging the place mark. 

 

 Search Panel 
The search panel is useful to quickly find a place of move the map to a specific 
geographic coordinate. 
 
To search for latitudes and longitudes, enter the coordinate in the form “<latitude>, 
<longitude>”. 
Use of the symbols for degrees, minutes and seconds is optional if each coordinate is 
appended with a “N/S” or “E/W” character. 
 
For example, entering… 
 51 31 54N, 0 7 23W or  

 51 31’ 54N”, 0 7’ 23W” or  

 Kings Cross Station London 
will jump the map view to Kings Cross railway station in London. 
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 5.8.4 Creating Mission Markers 

 
Creating the Mission Marker folder 
The first step to creating an Artemis Mission file in Google Earth is to create the places 
“folder” to organise the markers within. 
 To create a folder, either… 

o Left click on the “My Places” entry in the Places Bar to select it, then 
choose from the main menu “Add » Folder”, or 

o Right click on the “My Places” entry in the Places Bar, and choose “Add » 
Folder” from the pop-up menu. 

 A “New Folder” window will appear. In the text box next to the “Name” heading, 
enter the name Mission File as the folder name.  

 Press Enter, or click “OK” to create the folder. 

 In the places bar, a new folder entry will appear under “My Places” 
 

 

 

 
 
 

 

 

When exporting the markers, the name of this folder will be the default filename, 
although you may then change it to whatever you wish. 

 

If you have other entries under “My Places” in the Places Bar, and accidentally create 
the new folder in the wrong place (or level of the hierarchy), drag the new folder (with 
the left mouse button) over the top “My Places” heading to move it. 

 

If you wish to change the name of the folder, right click on it in the Places Bar, then 
select “Rename” (or “Properties”) from the pop-up menu. 

  
Placing Markers 
Having created the Mission Marker folder, the next step is to create and position the 
required mission markers. There are several ways of doing this, first we will place the 
markers visually on the map. 
 Use the mouse and map controls to pan and zoom the map area to the location that 

the mission markers will be placed in.  

 

If you are creating mission markers from a list of coordinates, enter the first 
coordinates into the Search Panel as described previously. 

  To create a new marker (that will initially appear at the centre of the current map 
view), either… 

o Left click on the newly created Mission Folder (see above) in the Places 

Click “OK” to create the 
folder. 

The new folder will appear in 
the Places Bar. 
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Bar to select it, then choose from the main menu “Add » Placemark”, or 

o Right click on the newly created Mission Folder in the Places Bar, and 
choose “Add » Placemark” from the pop-up menu. 

 The “New Placemark” window will appear. If this is over the work area of the map, 
drag the window title to move it out of the way. 

 Enter the name of the marker into the text box at the top of the Placemark window. 
This is not mandatory, but when imported the name will appear on the Divers 
display of the Artemis console (truncated to 12 characters if the one you enter here 
is longer). 

 On the map area, a push-pin icon will be shown (with flashing yellow box 
highlighting it – drag the push-pin icon to the desired marker location by holding 
down the left mouse button. 

 

While positioning the push-pin, you may use the map controls on the right side of the 
display to zoom or reposition the map, or use the left mouse button or mouse wheel 
over the map area. 

  If you have a known location for the marker, you may manually enter this in the 
“Latitude” and “Longitude” text boxes in the Placemark window. 

 Once you have positioned the push-pin, press Enter or click “OK” to confirm its 
position and stop editing. 

 Repeat the above steps for each marker you wish to add to the mission. Artemis 
can support up to 20 markers in a mission, but filling all 20 will prevent the diver 
from adding additional markers during the dive as there will be no space to store 
them in. 

 

 

 
 

 

If you have other entries under “My Places” in the Places Bar, and accidentally create 
the new Placemark in the wrong place (or level of the hierarchy), drag the new 
Placemark (with the left mouse button) over the top mission folder to move it into it. 
 

Hold down the left mouse 
button over the push-pin and 

drag it to move it. 

If required, reposition the 
map using the map controls. 

If required, modify coordinates here.

Click “OK” to finish 
positioning the marker. 

Notice the new marker has 
appeared UNDER the new 
mission folder heading. 
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If you wish to change the name or reposition the Placemark, right click on it in the 
Places Bar, then select “Properties” from the pop-up menu. The “Edit Placemark” 
window will then appear, and the push-pin can be dragged or repositioned as described 
above. 

 
 5.8.5 Exporting KML markers from Google Earth 

Once you have followed the previous procedures to create the mission marker folder, 
then add placemarks to it representing the mission targets and waypoints, you can 
export these markers into Artemis Manager via a KML file. 
 
The image below shows a fairly typical set of mission markers. Marker names have 
been chosen to be brief but descriptive to the diver (when shown on the Artemis 
Display). 
 
Notice how the markers have all been added to the “ArtemisMission” folder in the 
places bar, and the hierarchy shows them to be indented to the right from the folder 
name. 
 
If all the markers aren’t in the mission folder, at this stage drag them over the mission 
folder name to reposition them. Additionally, drag the markers names over each other 
within the mission folder to organise the sequence they will appear to the diver in (this 
can also be done later in Artemis Manager). 
 

 
 

 Once the markers are entered and have been organised correctly, export them to a 
KML file… 
 
 Start the export for just the required mission markers by either… 

o Selecting the mission folder to export in the Places Bar by left clicking on 
it, then choose from the main menu “File » Save » Save Place As”. 

o Right click on the mission folder to export in the Places Bar, then form 
the pop-up menu choose “Save Place As”. 

 The “Save File” window will appear. By default the mission folder name created 
previously will be used as the file name – if required, change this here. 
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 By default, Google Earth will try to export the markers in a KMZ format. As Artemis 
Manager requires a KML format, click the “Save as type” drop down list and choose 
the KML option. 

 Choose the file location you want to export the data to, then click “Save”. 
 

 

 
 

Check the KML save type is selected.

First, check the mission folder is 
selected before saving. 
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 5.8.6 Importing KML markers into Artemis Manager 

Once the markers have been exported from Google Earth, the can be imported into 
Artemis by the following steps… 
 First, start the Artemis Manager application  

 Click the “Missions” tab at the top of the screen. 

 Click on the “New Mission” button under the “Actions” heading – this will create a 
new empty mission file. 

 Click on the “Import Markers” button under the “Tools” heading. 

 From the pop-up menu choose “Import KML Markers” 
 

 

 

  When the “Import Mission Markers” window appears, find the file KML that was 
exported previously from Google Earth, and click “Open”. 

 The markers should be imported and the display should show something similar to… 
 

 

 

1) Choose “Missions”

2) Click “New Mission”

3) Click “Import Markers”

4) Click “Import KML Markers”
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  At this stage the mission file may now be saved ready for use with Artemis by 
clicking on “Save Mission As”. However, we may now wish to customise some of the 
marker properties… 

 For each marker shown in the “Navigation Markers” list, click on the “Type” and 
“Colour” entries to customise how the markers will appear to the diver. 

 
Markers can be chosen to be one of three types… 

  Target  Targets should be used to specify points of interest that the 
diver may wish to navigate to or be aware of. A choice of 
Red, Yellow, Green, Blue and Purple colours are available for 
target markers. 

  Waypoint  Waypoints are used to specify a search path/pattern and can 
be either dark or light gray in colour. Optionally, connecting 
lines can be shown on the Artemis display to assist the diver 
navigating the path. 

  Diver  Diver markers are normally placed during the dive are 
specified as “Diver” type to distinguish them from the pre-
dive “Targets”. However, you may wish to use the different 
symbol graphic to identify certain types of targets. 

  If required, reorganise the marker order by clicking on a marker entry and using the 
“Move Up” and “Move Down” buttons. 

 In the example below, the marker types and colours have been customised to show 
a navigation path for the diver made up from Waypoints, with known fixed objects 
shown in purple, while targets to investigate are highlighted in green – these colour 
conventions are arbitrary and up to the diver and dive supervisor to agree upon. 

 When done, click “Save Mission As” to save the mission file, then transfer it to 
Artemis using the USB cable and method discussed in the Artemis User Manual. 
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 5.8.7 Exporting Mission Markers to Google Earth 

For convenience or to allow further editing, Artemis Mission markers can be exported 
as a KML file and imported back into Google Earth. 
 Start with an open mission file in Artemis Manager. 

 Click on “Export Markers” under the “Tools” heading. 

 Click on “Export KML Markers” in the pop-up menu. 

 In the “Export Mission Markers” window, choose the location to save the KML file to, 
then click “Save”. 

 

 

 
 

  Switch back to Google Earth, and from the main menu choose “File » Open”. 

 From the “Open” window, find the location where the KML markers where exported 
to, select the file and click “Open” to load them into Google Earth. The display may 
then look like the following image… 

 

1) If required, open the mission file to export.

2) Click “Export Markers”

3) Click “Export KML Markers”
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 Notice that the marker colour and symbol have also been imported across, and the 
waypoint connecting lines added where required. 
 
Also notice that a new folder with the name of the file (in this case 
“ArtemisMission_markers”) has been created in the places bar under the “Temporary 
Places” heading. 
This means that these markers will not be saved by Google Earth when it is closed, 
unless they are dragged into the “My Places” category. 
 

 

Use the check-boxes to the left of the marker or folder names in the Places Bar, to 
toggle their visibility on the display if it becomes cluttered. 

 

Double click on a marker or folder name in the Places Bar to move the map view to 
show it. 
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6  DIVING ARTEMIS 

 Before diving with the Artemis console, please familiarise yourself will all aspects of the 
systems operation, as described in this manual. 
 

 
 

 

6.1 Pre-Dive Checklist 
Prior to a dive with the Artemis Console, please check all of the following actions have 
been completed... 
 
 There is enough free space on the internal storage for the Dive-Log file – allow 

approximately 2Mb of storage space per minute of the dive. 

 Any Mission file to be used has enough free “marker” slots to allow the diver to 
define any in-mission markers if required. 

 Battery pack is fully charged ( ) 

 Battery housing cap is tight and sealed. 

 Blanking plugs have been fitted to all unused connectors (Serial and USB) to 
prevent water ingress. 

 If the Sonar is to be used, check the Sonar status icon ( ) on the Artemis Display 
status bar is visible and white (red indicates no Sonar connected, yellow indicated 
invalid data). 

 If the GPS Float is to be used, check the GPS status icon ( ) on the Artemis Display 
status bar is visible and white (red indicates no GPS connected, yellow indicates 
data, but not GPS fix determined).  

 

 
 

 

6.2 Summary of Sonar Operation 
The following points summarise the operation of the sonar (for further details, see 
page 60) … 
 
 Hold the sonar horizontally and stationary for a few seconds while a full scan 

completes. Moving the sonar during a scan will smear or distort the imagery. 

 Only targets illuminated by the sonar beam can be seen – 35° in the vertical plane, 
3° in the horizontal plane, scanning through a 90° arc. 
With the sonar angled horizontally, this means targets above and below the 
operator by approximately 17° degrees may not be seen. 

 The polar sonar display shows “top-down” type display of the echoes received from 
the targets leading edges. 

 Targets cast acoustic shadows, which may obscure all or parts of targets behind 
them. 

 Dense or gaseous targets appear brightest on the display, while mud and silt will 
appear very dull. 

 As no vertical information is available, vertically aligned or overlapping targets in 
the sonar beam will merge into a single echo. 

 Use the gain control to reduce the background noise reflections in a high clutter 
(rocky/boulder) environment.  
When scrutinizing a target at close range (within 3m range) in turbid or nil visibility, 
the gain is particularly useful in establishing the shape, constitution and dimensions 
of the target being prosecuted. 
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6.3 Recommended Operational Procedures 
 

6.3.1 Searching Within 30 Metres of a Known Target Position 
The following operational procedure is recommended when searching within 30 metres 
of a known seabed target position… 
 
 Check that Artemis has been prepared in accordance with the instructions in this 

manual, and the pre-dive checklist above, and the Sonar is fitted. 

 Cycle through the Artemis displays to the Sonar Application, then set the sonar to a 
40m range scale, 50% gain. 

 Diver leaves surface and descends to seabed.  

 When the Artemis console is submerged, the Dive Log file start recording (if the 
immersion sensor is enabled) – alternately, start logging using the “Start Dive” 
option from the Settings display. 

 When ready to proceed, diver holds Artemis approximately 0.5m above seabed at 
chest height and holds the unit on a steady bearing. If possible, the diver should 
kneel on the seabed with Artemis horizontal and at chest height.  

 The Diver should let Artemis scan for at least 3 sweeps on each bearing. The centre 
bearing can be changed by the diver at any time but 45 degree changes are 
recommended. 

 When the diver believes the target has been acquired, he closes the range. The 
target should be kept in the centre of the Sonar Display. 
As a rule of thumb; 

o If the target is presenting on the left hand side of the Sonar display, the 
Artemis console should be trained left which will bring the target to the centre 
of the Sonar Display. 

o If the target is presenting on the right hand side of the Sonar display, the 
Artemis console should be trained right which will bring the target to the centre 
of the Sonar Display. 

o The Navigation Application, Status Bar digital readout or Magnetic Compass can 
be used to assist bearing guidance. 

 With the target in the centre of the display, the diver continues to close the range 
until either the target becomes visual (visibility permitting) and/or the target can be 
seen on the minimum range scale (1m) of the Sonar Display.  

 In bad visibility care should be taken to ensure that a safe distance is observed 
from the target where interaction with the same could compromise the safety of the 
diver. 

 

 

For further information on using the Sonar, please refer to sections 4.5 (Sonar 
Application) and 7 (Understanding Sonar Imagery). 
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 6.3.2 Navigation Using the GPS Float 

The following operational procedure is recommended when underwater navigation 
using the GPS Float is required. 
 
 If required, use the Artemis Manager PC software to prepare a Mission File 

containing the positions (latitude and longitudes) of search-pattern waypoints or 
targets of interest to navigate to. Use the USB cable to download the mission file 
onto the Artemis console. 
For more information on Mission Files, see page 35. 

 Check that Artemis has been prepared in accordance with the instructions in this 
manual, and the pre-dive checklist above, and is fitted with the GPS Float. 

 Once the unit is switched on, the GPS signal will obtain a fix after a few minutes 
providing that a satisfactory GPS signal can be obtained.  
The quality of the GPS Position displayed on the screen should be compared where 
possible to another GPS source (from the RhiB or operating platform to confirm 
correlation). 

 Cycle through the Artemis displays to the Navigation Application, then (if defined) 
select the required destination marker (waypoint or target) from the Mission file.  
The Range and Bearing to the destination marker will also be displayed. The diver 
can use the Navigation system for guidance to the datum as indicated. 

 When the Artemis console is submerged, the Dive Log file start recording (if the 
immersion sensor is enabled) – alternately, start logging using the “Start Dive” 
option from the Settings display. 

 Should the diver chance upon an unknown target during his sortie, the position of 
the target can be marked by pressing the “Mark Target” button on the console. 
This will record the geodetic position of the target.  
The accuracy can be improved by the diver drawing the surface float above him to 
reduce the lay-back offset described by the position of the float at the point at 
which the position is recorded.  

 In total, Artemis can hold 20 markers in a Mission. When specifying pre-dive 
targets, ensure the mission file has sufficient space for any additional targets to be 
marked during the dive. 

 Upon return to the surface, connect Artemis to a PC through the USB cable, and 
download the relevant “Dive Log” files. These can be opened in the Artemis 
Manager PC application, and data analysed or exported to third-party applications. 

 
For further details on navigation, refer to the Navigation Application in section 4.6 
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7 UNDERSTANDING SONAR IMAGERY 

 Interpreting sonar imagery may seem challenging at first, but with practice and some 
knowledge of how the sonar works, it doesn’t take very long for an operator to 
understand what the sonar image represents. 
 
Many people try to look at the pictures and understand them as you would a 
photograph, but this however is not strictly the case. In the following sections, we will 
look at how the sonar produces its images, and see how information can be obtained 
from them. 
 

 

 

Basic Operation  
The Sonar used by Artemis is a “forward looking, scanning sonar”. In simple terms the 
acoustic beam produced by the sonar is much like that of a torch beam having a 
vertical and horizontal beam width.  
 
The sonar will build up an image of echoes it receives from targets in front of it by 
mechanically scanning a narrow (approx 3° horizontal width) wide acoustic sound beam 
horizontally through a 90° arc, performing “pings” at set intervals. 
 
When an object is ‘illuminated” within the sonar beam, the sound energy reflects off 
the target and is presented on the Artemis sonar display. The size of the object on the 
display is a function of the size of the target itself and the range at which it is 
observed. 
 
The operator should hold the Artemis console (and sonar) horizontally, and stationary 
for a few seconds while a full scan completes. If the sonar is moved or rotated during a 
scan, the resulting image will appear smeared and distorted. 
 
For relocation of large objects, wrecks, jetties, underwater swimmer delivery vehicles 
and the like, it is possible to use the maximum range of 100m.  
Once the object has been detected, the diver can close the range, changing the Range 
Scales as the target range is closed. 
 
For relocation of smaller objects such as mines, depth charges, etc it is recommended 
that the diver is placed as close as possible to the datum position (within 50m 
preferably). 
 

 Range & Gain Controls 
The sonar has two main controls the help optimise the image; Range and Gain. 
 
The range control allows the operator to choose the maximum range targets will be 
shown at on the display. As sound travels at a fixed speed through water, increasing 
the range means the sonar must wait longer to collect echoes from more distant 
targets and so the scan rate will slow down, while shorter ranges will cause the sonar 
to scan faster. 
 
The gain control can be thought of like a “volume” control – increasing the gain will 
amplify fainter echoes making the entire display appear brighter (and possibly saturate 
some target detail), while decreasing the gain will dim the display (possibly hiding 
fainter targets, but making it possible to detect texture and detail on others). 
 
Gain is mainly used to reduce the background clutter reflections in a high clutter 
(rocky/boulder) environment. By reducing the gain, the clutter and seabed 
reverberations can be reduced on the Sonar display making the initial detection of the 
target easier to see. 
 
When scrutinizing a target at close range (within 3m range) in turbid or nil visibility, 
the gain is particularly useful in establishing the shape, constitution and dimensions of 
the target being prosecuted. 
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 Target Visibility 

Targets that lie within the 90° sector (and the range of the sonar) will be shown on the 
display, while targets that lie outside this area can’t be shown. 
 

 

In the vertical plane, the sonar beam is 35° wide (regardless of scan angle), and again 
targets within this beam will be visible, while targets above or below won’t be seen… 

  

 
 
For each mechanical scan position, the sonar display shows the received echo strength 
(as colour brightness) against distance from the sonar. This means the display could be 
thought of as being very similar to an overhead “satellite” image, but with a few key 
differences, discussed below… 
 

 Target (& Echo) Intensity 
As the acoustic beam scans across the 90° field of vision, the sound travels from the 
sonar (at approximately 1500 metres per second in water) until it hits the first target in 
its path.  
 
Depending on its composition, the target then reflects some proportion of this acoustic 
energy back towards the sonar, which is received and displayed (with a colour 
corresponding to the sound level received).  
 

 

The greater the density difference of the target is to water, the more acoustic energy is 
reflected. 
 Gas bubbles, photo-synthesising aquatic plants, rocks, or any gas filled thin walled 

targets will appear very brightly along with very solid metal or concrete structures. 

 Thin walled, water-filled or water-logged targets (i.e. barrels, canisters, wooden 
crates etc) will reflect some, but not as much sound as a solid target. 

 Mud, silt or other particles in suspension are good absorbers and will return very 
little acoustic energy. 
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 Acoustic Shadows 

Similar to an object casting a shadow when illuminated with a narrow torch beam, 
underwater targets can cast “acoustic shadows” in the sound beam, meaning any 
further targets behind them will not be visible if they lie fully within the shadow. 
 
The figure below show a selection of spherical and rectangular targets in the sonar’s 
field of vision. As well as the shadows they create, the leading edges of the targets 
have been highlighted to surfaces the sound is reflected from, and ultimately this is 
what is shown on the display…  
 

 

 If a target is partly obscured by another target in front of it, the returns echo will be a 
combination of the horizontal profile of both targets, and this can be seen in the “Sonar 
Display” in the figure above. 

 

 

Vertical Targets 
As the sonar only scans horizontally, is cannot determine if a target lies above or below 
it, and this means no vertical information is available to the operator.  
 
If two targets are positioned along the same scan angle with one vertically above the 
other at the same range from the sonar, then the sonar will not be able to tell the two 
apart, and their echoes will merge into one result on the image, with the more 
reflective target being dominant on the display. 

 
 

However, by moving location, the echoes will separate and both targets will become 
visible. 
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8 TROUBLESHOOTING 

 

Below is a table of common problems and solutions, but if you have a problem that 
cannot be solved from the table below, or an issue that is not covered, please contact 
technical support - see page 64 for further details. 
 

 Problem… Solution(s)… 

 On power up, a white screen is 
observed and the unit shuts down after 
10 seconds. 

This has occasionally been observed when a 
very flat battery is used to power the 
system. Fully charge the battery and try 
powering the system on again. 
 

 The digital compass direction is erratic. The compass direction can be thrown off by 
the presence of magnetic fields from ferrous 
materials. On vessels, engines and the hull 
can be a large contributing factor to this. 
 
Try using Artemis in a large clear area away 
from any metals, and if this fails to stabilise 
the compass, try performing a compass 
calibration. 
 
The presence of the analogue compass 
module will affect the digital compass 
reading (as it contains a magnet itself). If 
present, remove the analogue compass 
module. 
 

 The Sonar / GPS do not connect. Check the devices are plugged into the 
correct serial-port connectors on Artemis. By 
default the Sonar is configured for port 1, 
and the GPS for port 2. 
 
From connection, the GPS status bar 
indicator should be yellow when connection 
is established by waiting for first fix, this 
process can take 2 or 3 minutes to complete 
– if the period is longer, move the GPS 
antenna to an area that allows improved 
visibility of the satellites, and does not 
attenuate their signals. 
 

 The depth sensor reading is offset. At atmospheric pressure changes, it may 
have a small effect on the reading of the 
depth sensor. Before every dive, zero the 
depth sensor at the surface using the “zero 
depth sensor” function from the “Dive 
Profile” application. 
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9  PRODUCT SUPPORT 

 
9.1 Artemis Website 
For the latest software and firmware updates, as well as production information, 
manuals and datasheets, visit www.blueprintsubsea.com/artemis. 
 
We welcome any feedback you may have about the Artemis system, from bug reports 
to ideas for new features or hardware to support – please use the contact details on 
the website (or shown below) to get in touch. 

 
 

9.2 Technical Support 
If your Artemis system is not operating properly, please consult the ‘Troubleshooting’ 
section of this manual and further information on the Artemis website to see if the 
problem can be easily remedied. 
 
However, if you need further support, you can contact us at… 
 

  Web 
www.blueprintsubsea.com/artemis 
(for access to on-line resources and technical support) 

  Email enquiries@blueprintsubsea.com 

  Call us 
+44 (0)1539 531536 
(9:00am to 5:00pm, Monday to Friday, GMT) 

  
For all of the above please provide the following information, where appropriate and if 
possible, to help us with your technical support request… 
 
 Part and Serial Numbers of the system components. These are located on the labels 

of each item, and are in the form “BPxxxxx.xxxxxx”. 

 Version number of the ‘Artemis’ software and firmware you are using. 

 The operating system name, version, type (32 bit or 64 bit) and service pack 
upgrade your computer is using. 

 Brand and model of your computer (processor type and memory configuration is 
also useful if known). 

 Name of the distributor where the system was purchased from. 

 

 

If you have to return your Artemis system for servicing, please… 
 
 Contact us (using the details above) for a “Returned Materials Authorisation” (RMA) 

number, and shipping details. 

 Pack your Artemis system back in the original packaging (or other suitable 
container), and include written documentation including your contact details 
(including contact phone number), the RMA number and a description of the 
problem and any symptoms occurring. 

 If your product is still under warranty, please include a copy of your receipt 
(showing proof and date of purchase). 

 Please return the product back to Blueprint Design Engineering Ltd, using an 
insured courier and delivery confirmation. 

 

http://www.blueprintsubsea.com/artemis�
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10 LIMITED WARRANTY POLICY 

 The manufacturer, Blueprint Design Engineering Ltd (herein after referred to as 
Blueprint), warrants that at the time of shipment all products shall be free from defects 
in material and workmanship and suitable for the purpose specified in the product 
literature. 
 
The system warranty commences immediately from the date of customer acceptance 
and runs for a period of 365 days. Customer acceptance will always be deemed to have 
occurred within 72 hours of delivery. 
 
Conditions 
These include, but are not limited to, the following: 
1. The warranty is only deemed to be valid if the equipment was sold through 

Blueprint or one of its approved distributors. 

2. The equipment must have been installed and commissioned in strict accordance 
with approved technical standards and specifications and for the purpose that the 
system was designed. 

3. The warranty is not transferable. 

4. Blueprint must be notified immediately (in writing) of any suspected defect and if 
advised by Blueprint, the equipment subject to the defect shall be returned by the 
customer to Blueprint, via a suitable mode of transportation and shall be freight 
paid. 

5. The warranty does not apply to defects that have been caused by failure to follow 
the recommended installation or maintenance procedures, or defects resulting 
from normal wear & tear, incorrect operation, fire, water ingress, lightning damage 
or fluctuations in vehicles supply voltages, or from any other circumstances that 
may arise after delivery that is out with the control of Blueprint. (Note: The 
warranty does not apply in the event where a defect has been caused by isolation 
incompatibilities.) 

6. The warranty does not cover the transportation of personnel and per diem 
allowances relating to any repair or replacement. 

7. The warranty does not cover any direct, indirect, punitive, special consequential 
damages or any damages whatsoever arising out of or connected with misuse of 
this product. 

8. Any equipment or parts returned under warranty provisions will be returned to the 
customer freight prepaid by Blueprint 

9. The warranty shall become invalid if the customer attempts to repair or modify the 
equipment without appropriate written authority being first received from 
Blueprint. 

10. Blueprint retains the sole right to accept or reject any warranty claim. 

11. Each product is carefully examined and checked before it is shipped. It should 
therefore be visually and operationally checked as soon as it is received. If it is 
damaged in anyway, a claim should be filed with the courier and Blueprint notified 
of the damage. 

 

Blueprint reserve the right to change specifications at any time without notice and 
without any obligation to incorporate new features in instruments previously sold.  
 
If the system is not covered by warranty, or if it is determined that the fault is caused 
by misuse, repair will be billed to the customer, and an estimate submitted for 
customer approval before the commencement of repairs. 
 
Any customer acceptance testing (if applicable) must be performed at either Blueprint 
premises or at one of their approved distributors unless mutually agreed in writing 
prior to despatch. 
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11 NOTICES 

 Copyright Notice 
Blueprint Subsea is a trading name of Blueprint Design Engineering Ltd. 
Copyright © 2015 Blueprint Design Engineering Limited, all rights reserved.  
No part of this publication may be reproduced, stored in a retrieval system, or transmitted 
in any form or by means (electronic, mechanical, photocopying, recording or otherwise), 
without the prior written permission of Blueprint Design Engineering Ltd. 

 Disclaimer 
Neither Blueprint Design Engineering Ltd., or their affiliates shall be liable to the purchaser 
of this product, or third parties, for losses, costs, damages or expenses incurred by the 
purchaser or third parties as a result of accident, misuse, abuse, modification of this 
product or a failure to strictly comply with the operating and maintenance instructions.  

 Trademarks 
The Windows™ operating system is a trademark of the Microsoft Corporation. The Google 
Earth™ mapping service is a trademark of Google Inc. Other product and brand names used 
within this document are for identification purposes only. Blueprint Design Engineering Ltd. 
disclaims any and all rights in those marks. 

 Third-Party Software Applications 
Third-party applications referred to in this document (such as Google Earth and Microsoft 
Windows) are not affiliated with Blueprint Design Engineering Ltd. in any way, and the 
content provided here is on an “as is” basis for information only. Blueprint Design 
Engineering Ltd. can offer no technical support for these applications (unless stated 
otherwise in the text), or accept responsibility whatsoever for any damages arising out of 
the use of information contained in the documentation by other parties, and makes no 
guarantees, expressed or implied, about its availability, quality, reliability, functionality or 
any other characteristic. 

 Specifications & Content 
All information in this document is believed to be correct at the time of going to press, 
Blueprint Design Engineering Ltd cannot be held responsible for any inaccuracies or 
omissions. If you find an error or feel we have missed important or useful information, 
please contact us. The latest version of the manual is always available to download from 
the website. 
Specifications and information contained in this document is subject to change without 
notice, and does not represent a commitment on the part of Blueprint Design Engineering 
Ltd. 

 

Handling Recommendations 
The Artemis system contains sensitive electronic components that may be damaged by an 
Electrostatic Discharge (ESD) if handled incorrectly. To minimise risk, avoid dismantling the 
unit, touching any exposed electrical contacts on external connector, or inserting anything 
other than the recommended cabling into the connectors. 

 

Waste Electrical & Electronic Equipment Statement  
Under the European Union (EU) directive on 'Waste Electrical & Electronic Equipment' 
(Directive 2002/96/EC), from August 13, 2005, products categorised as electrical or 
electronic equipment cannot be discarded as municipal waste by placing in landfill, dumping 
in the sea or incineration. SEPARATE collection is mandatory. 
At the end of its life, you should either return this system and its associated leads & 
accessories (if appropriate) to Blueprint Design Engineering Ltd with a certificate of 
decontamination (we reserve the right to protect our staff from the effects of any 
contamination) or it should be sent to an appropriate treatment or recycling agency. 

 

Restriction of Hazardous Substances Statement 
Under the European Union (EU) directive on the 'Restriction of Hazardous Substances' 
(Directive 2002/95/EC), from July 1, 2006, electrical and electronic equipment cannot 
contain lead ("lead free"), mercury, cadmium, hexavalent chromium, polybrominated 
biphenyls (PBB) or polybrominated diphenyl ethers (PBDE). 
All components of the Artemis system, sold by Blueprint Design Engineering Ltd, fully 
comply with this legislation where applicable. 
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12 SPECIFICATIONS 

12.1 Console 
Dimensions 340mm long × 240mm wide × 125 mm high 

Weight Artemis and Battery only… 
2.6kg (in air) 
0.8kg (in water) 

Artemis with GPS Skid option… 
4.3kg (in air) 
0.6kg (in water) 

Construction Black acetal plastic 

Temperature 
Range 

-10°C to +35°C operating and storage 

Operating Depth 100msw (11 BAbs) 
 

12.2 Display Unit 
Power Supply 16.8V DC nominal from supplied battery pack (or 7V to 28V DC input 

range from external source) 

Processor 150MHz low-power consumption ARM processor 

Display Tilted 3.5”, 320 × 240 pixel, 16-bit colour Liquid Crystal Display 

Data Storage & 
Logging 

Internal 16Gb non volatile ‘Flash’ memory (other capacities available on 
request). 
Data Logging capacity (assuming approx 2Mb per minute) > 100hrs on 
internal storage. 

Integrated 
Sensors 

Pressure sensor for depth calculation 
Attitude and Heading reference system (comprising pitch and roll, 
digitally gimballed electronic magnetic compass and rotational rate 
gyros) 
Battery voltage level indicator 

User Interface 5 × solid-state piezo button interface for menu navigation and 
parameter control 

Communications 
Interface 

3 × switched power RS-232 serial ports (for connection to Sonar and 
GPS modules) 
USB port for connection to a PC (appears as a ‘pen-drive’ style mass 
storage device, for downloading logged data files) 

Connectors Fischer UltiMate series connectors… 
1 × 2 pin DC power 
3 × 4 pin Peripheral connector (switched output power and serial 
communications) 
1 × 7 pin USB connector (to standard USB ‘A’ type plug) 

 

12.3 Battery Pack 
Battery Type 16.8V, 2.2Ah capacity, rechargeable Nickel Metal Hydride (NiMH) 

interchangeable pack. 

Operating Time 
(from charged 
battery pack) 

Approx 5-6 hours (with Sonar and GPS connected). 
(actual operating time depends on battery age, environmental 
temperature and charge state at the start of the dive) 

Charging Time No more than 7 hours, from a fully discharged state. 

Safety Integrated thermal fuse (94°C) and electrical fuse (5A) 

Temperature 
Range 

-10°C to +35°C operating and storage  
(NB: Elevated temperatures lead to greater self discharge rates) 
+10°C to +30°C charging 
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12.4 Battery Charger 
Mains input 90-264V AC, 50-60Hz 

Housing 90mm × 45mm × 32mm. Black ABS Plastic. 

Additional 
Features 

Smart multi-stage charge regime (with over charge protection, top-off 
timer and trickle charge) 
3-colour charge state indication LED 

Environmental 
Rating 

IP41 

Temperature 
Range 

-20°C to +40°C operating 
(NB: See also Battery Pack charging temperature range) 

 

12.5 Sonar 
Operating 
Frequency 

Chirped 650kHz to 750kHz 

Beam Geometry 35° vertical, 3° horizontal 

Dimensions 56mm diameter, 78.5mm high 

Weight 320g (in air), 180g (in water) 

Range Settings From 1m to 100m in preset steps  
(1m, 2m, 5m, 10m, 20m, 30m, 50m, 100m) 

 

12.6 GPS Skid & Float 
Dimensions 360mm(L) x 110mm(W) x 120mm(H) (excluding wound cable) 

Weight 1.7kg in air 
0.2kg positively buoyant in water (float attached to skid) 

Cable length 40m (consult factory for other lengths) 

GPS Receiver GPS L1 C/A-code, SPS. 66 acquisition and 22 tracking channels 

Data Output 1Hz output interval, standard NMEA RMC, GGA, GSV and GSA strings 
based around WGS84 datum. 9600 baud RS232 serial data 
communications 

Sensitivity -148dBm (Cold Start Acquisition) 
-165dBm (Navigation) 

Datum WGS84 
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